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'Login’

‘Login’

Introduction

Depending on the application configuration, it may be necessary to identify yourself.
You have to enter your user name and password.

'Login’
1. Enter your user name.

2. Enter your password.
3. Click 'Login'.

Note:
. A "Web user' or 'LDAP user' can login to the server when that user belongs to the 'Ser-
vices' group.

. Note:
A "Windows user' can login to the server when that user is a system administrator.
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Introduction

Introduction

All existing job tickets items are stored in the job ticket definition. The job ticket definition
is stored on the Central Server.

The 'Trems' section displays all items of the job ticket definition. The Job ticket editor
allows you to create and change job ticket items.

The 'Views' section displays the different views on the job ticket definition. The Job
ticket editor allows you to add or remove job ticket items for the different views.

The 'Items’ section

The 'Ttems' section displays all items of the job ticket definition.

You can add or remove items from the job ticket definition. When you create a new item,
you will enter an item name and item type. When you have created a new item, a dialog
will be displayed allowing you to configure the item's settings. The settings displayed
depend on the item type that you have selected. You can also delete items from the job
ticket definition, but some items are predefined and connected to system files. These
items can not be deleted permanently. When you have completed updating the job ticket,
you have to save the ticket. The views on the job ticket will not change unless you save
your changes.

The value of the job ticket item can be read-only or editable. When the item is editable,
the value of the item can be defined as required.

You can open the 'Properties’ of an item to configure if the item is editable or read-only on
page 16.

In the job ticket definition you can define settings items and group items. Settings items
are items that carry a value. Group items allow you to sort setting items together in the
job ticket. You can define to which group each settings item belongs to. You can always
change the group afterwards.

Select if you want to show or hide job ticket items in the 'Items' section:

Listed items
Item Description
"View settings The job ticket items that contain settings are displayed.
items'

"View group items' | The job ticket items that group the settings items are displayed.

'Show all' Both groups and items are displayed in one list.
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Introduction

The "Views' section

The 'Views' section displays the different views on the job ticket definition.

All existing job tickets items are stored in the job ticket definition. "Web Submission'
users need access to a subset of the job ticket items. The operator needs all job ticket items
of the "Web Submission' users and some extra items. Therefore, the operator needs a
different view on the job ticket definition than "Web Submission" users. You can, for ex-
ample, add an item 'IntakeOperator’ in the operator view. The name of the operator can
be entered in this item when the print job is finished. The item is only visible in the op-
erator console and will not be displayed in the Web Submission.

The 'Views' section contains two panes. In the left pane, the layout of the job ticket is
shown. The layout consists of group items. The right pane displays the content of a se-
lected group item. A group item can contain more group items and/or setting items.

Several views on the job ticket definition are available:

= 'Print order'
The users of "Web Submission" have this view on the job ticket available.

= 'Operator’
The operator has this view on the job ticket available in the 'Operator console'.
This view contains:
- All job ticket items of the 'Print order' view.
- Operator specific job ticket items, for example 'IntakeOperator'. The name of the
operator can be entered in this item when the print job is finished.

= 'DeskSub'
The operator has this view on the job ticket when the operator creates a 'New job...'
in the 'Operator console'.

Select one of the available views from the drop-down list box 'Views'.

To add an item to a view, you select the item in the items list and drag the item to the
job ticket. The item will be added to the job ticket at the position where you drop the
item in the job ticket.

The job ticket editor allows you to remove items from a specific view.

When you have completed updating the job ticket, you have to save the ticket. The views
on the job ticket will not change unless you save your changes.
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Creating new items

Creating new items

Introduction

Before you can add an item to the job ticket, you have to create and configure the item.
All created items are displayed in the 'Ttems' list.

If you want to add the item to two views, you do not have to create the item twice. You
must create the item once and add the item to both views separately.

Create a new item

1. Click 'New item', or
Click 'Edit' - 'Ttem' - 'New item'.
The 'New item' dialog opens.

2. Define the 'Ttem name:'

. Note:
The item name that you specify has to be unique. Once you have created the item, you
cannot change the item name or item type afterwards. The item name can contain the
following characters: 'a. - z.", 'A. - Z.", 'o. - 9.", '’

3. Define the 'Item type:'. You can select one of the following item types:

Item types
Item Description
"Text' You can define a text item as single-line or multi line.

A multi line item allows the user to enter more than one line
of text. You can specify the maximum number of characters
that can be entered. Items like 'Remarks' or "Comments' are
generally defined as multi-line. If you don't want the user to
enter more than one line, select the 'Single line' option. The
text you enter will be displayed as the default string in the job
ticket.

This job ticket item is a settings item.
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Creating new items

Item
'Choice’

‘ Description

Choice items allow the users to pick an option from the available
options in a drop-down list.

To add items to the list, you click the 'New' button. When you
select an item and click the 'Edit’ button, you can change the
‘caption’. This 'caption' option allows you to specify the way
the choice item will be displayed. This 'caption' name can devi-
ate from the chosen choice item name.

You can configure the sorting order by using the 'Up' and
'Down' buttons.

When you have entered all the available options, use the 'De-
fault’ option to specify the option that will act as a default for
the item.

This job ticket item is a settings item.

'"Date’

You define an item as 'Date’ to allow users to specify a certain
number of days. Use option 'Action date is today plus number
of days' to define when an action must be executed at the latest.
The action pertains to the job. When you enter ‘o’ here, the
current date will be displayed when the item is used. If you enter
a number, the number will be added to the current date and
the resulting date will be displayed.

This job ticket item is a settings item.

'Number'

Allows users to enter a numeric value.

When you define a number item, you define the minimum
value, the maximum value and the default value.

This job ticket item is a settings item.

"Yes/No'

Allows users to enable or disable an item.

For yes/no items, you define the default value of the item. If
you select the checkbox, the default value will be 'Yes'. If you
deselect the option the default value will be 'No'.

This job ticket item is a settings item.

'Group'

This job ticket item is a group item. You can use a group item
to group settings items.

. Language

The current default language will be displayed here.

. Click '"Mark color'.

The 'Edit item' dialog opens.
Configure the job ticket item on page 14.

Chapter 3 - The ‘Items' section
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Edit items

Edit items

Introduction

When you have created a new item, a dialog will be displayed allowing you to adjust the
item's settings.

Edit an item

1. Click 'Mark color". Or
Click 'Edit' - 'Ttem' - 'Edit item'.

2. The item name, item type and language are displayed, but can not be changed in this
dialog.

3. Define the "Tree caption:'.
The "Tree caption:' is the displayed name of the item in the job ticket.
For example, a group item 'Media' exists. You add a settings item called 'Color" to this
group. The "Tree caption:' becomes 'Color'.

4. Define the 'List caption:'.
The operator can display columns in the 'Operator console'. The 'List caption:' is the
displayed name of the job ticket item when the item is used as column header.
For example, a group item 'Media' exists. You add a settings item called 'Color' to this
group. The 'List caption:" becomes 'Media color'. Just 'Color’ is insufficient as column
header, since it can also be the color of a cover.

5. The settings displayed depend on the item type that you have selected.

Item types
Item Description
"Text' You can define a text item as single-line or multdi line.

A multi line item allows the user to enter more than one line
of text. You can specify the maximum number of characters
that can be entered. Items like 'Remarks' or "Comments' are
generally defined as multi-line. If you don't want the user to
enter more than one line, select the 'Single line' option. The
text you enter will be displayed as the default string in the job
ticket.

This job ticket item is a settings item.
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Edit items

Item
'Choice’

‘ Description

Choice items allow the users to pick an option from the available
options in a drop-down list.

To add items to the list, you click the 'New' button. When you
select an item and click the 'Edit’ button, you can change the
‘caption’. This 'caption' option allows you to specify the way
the choice item will be displayed. This 'caption' name can devi-
ate from the chosen choice item name.

You can configure the sorting order by using the 'Up' and
'Down' buttons.

When you have entered all the available options, use the 'De-
fault’ option to specify the option that will act as a default for
the item.

This job ticket item is a settings item.

'"Date’

You define an item as 'Date’ to allow users to specify a certain
number of days. Use option 'Action date is today plus number
of days' to define when an action must be executed at the latest.
The action pertains to the job. When you enter ‘o’ here, the
current date will be displayed when the item is used. If you enter
a number, the number will be added to the current date and
the resulting date will be displayed.

This job ticket item is a settings item.

'Number'

Allows users to enter a numeric value.

When you define a number item, you define the minimum
value, the maximum value and the default value.

This job ticket item is a settings item.

"Yes/No'

Allows users to enable or disable an item.

For yes/no items, you define the default value of the item. If
you select the checkbox, the default value will be 'Yes'. If you
deselect the option the default value will be 'No'.

This job ticket item is a settings item.

'Group'

This job ticket item is a group item. You can use a group item
to group settings items.

. The 'Log item' option allows you to specify if the item should be visible in the log file.
. Define the options for the item value on page 16. The value of the job ticket item can be
read-only or editable. When the item is editable, the value of the item can be defined as

required.

Chapter 3 - The ‘Items' section
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'Define options for item value'

‘Define options for item value'

Introduction

The value of the job ticket item can be read-only or editable. When the item is editable,
the value of the item can be defined as required.

'Define options for item value'
1. Click 'Edit' - 'Item' - 'Properties’. Or
Click 'Properties’ in the 'Views' section. Or
Double-click the job ticket item in the right pane of the 'Views' section.
The 'Define options for item value' dialog opens.

2. Select the option for the value of the job ticket item:
'Define options for item value'

Item Description

'Value is read-only' | If you select the 'Read-only' option, the user will not be able
to change the content of the item.

'Value is editable’ | Ifyou select the 'Editable’ option, the user will be able to change
the content of the item.

"Value is required’ | If you select the 'Required’ option you force the user to specify
the item, otherwise the user will not be able to process the job.
The 'Required’ option is available when you select the 'Editable’
option. The 'Required’ option is available for text items only.

16 Chapter 3 - The 'Iltems’ section



Delete an item

Delete an item

Introduction

When you delete an item in the 'Ttems' section, the item is marked for deletion. An item
is grayed out when the item is marked for deletion. When you save the job ticket defini-
tion, the deleted item is removed from the job ticket definition permanently.

When you have marked an item for deletion, you can restore the item.

Delete an item

1. Select the item in the 'Items' section.
2. Click 'Mark color'. Or
Click 'Edit' - 'Ttem' - 'Delete item'.
If the item is added to one or more views, you must confirm that you want to delete this
item.
The item is marked for deletion.
3. Click 'File' - 'Save'.
The item is removed from the job ticket definition.

Note:

. Some items are predefined and connected to system files. These items can not be deleted
permanently. 'Author' and 'User ID' are examples of such items. When you select such
an item, the 'Delete item' button will be disabled.

Restore an item

1. Select the item, which is marked for deletion.

An item is grayed out when the item is marked for deletion.
2. Click 'Mark color'.

The item is restored and will not be deleted.

Chapter 3 - The ‘Items' section 17
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Specify the item language settings

Introduction

The 'Editc' menu allows you to add and remove languages within the Job ticket editor.

Add languages
1. Click 'Edit' - 'Languages'.
2. Click 'Mark color'.
The 'Add language' dialog will appear.
3. Select the language that you want to add from the drop-down list.
4. Click 'OK' to confirm the changes and close the dialog.

Remove languages
1. Click 'Edit’ - 'Languages'.
2. Click 'Mark color'.
The 'Remove language' dialog will appear.
Select the language that you want to remove from the drop-down list.
4. Click 'OK' to confirm the changes and close the dialog.

»

Specify the item language settings

1. Select the item in the left section.
2. Click 'Edit' - 'Item' - 'Edit item’'.
The 'Edit item' dialog will appear.
3. Use the 'Language' drop-down box to select the language.
4. Specify the '"Tree caption' and the 'List caption' for the selected language.
5. Click 'OK' to apply the changes and close the dialog.
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Adding new item to a view

Adding new item to a view

Introduction

Before you can add an item to the job ticket, you have to create and configure the item.
All created items are displayed in the 'Ttems' list.

If you want to add the item to two views, you do not have to create the item twice. You
must create the item once and add the item to both views separately.

When you have completed updating the job ticket, you have to save the ticket. The views
on the job ticket will not change unless you save your changes.

To add a new item to a view

Select one of the available views from the drop-down list box 'Views'.

Select the item in the 'Ttems' section.

Open the group that you want to add the item to.

The group items are displayed in the left window of the "Views' section.

The items in the group are displayed in the right window

Drag the item from the items list to the exact position in the right window.

When you drop the item at a group name, the item will be added to that group, below
the existing items

To change the position of the item within a group drag the item in the group to the new
position.
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Changing the order of items

Changing the order of items

Introduction

You can change the order of items in the job ticket in two ways:

1. Change the group the item belongs to
When you initially add an item to a view, you specify the group the item belongs to. The
use of groups allows you to sort related items together in the job ticket. You can change
the group by selecting the item in the current group and drag the item to the new group
in the groups view. The item is added where you drop it. You can change the exact position
of the item within the group afterwards.
When you select the 'Root’ group, you can also drag the item into the root. The item is
added where you drop i.

2. Change the order of an item in a group
To change the order of items within groups select the item in the group and drag the
item to the new position within the group.

Chapter 4 - The 'Views' section 21



Removing item from a view

Removing item from a view

Introduction

The job ticket editor allows you to remove items from a specific view.

Removing item from a view

1. To remove an item from the job ticket, select the specific view, select the item in the view
in the right section.
2. Click the 'Remove item' button above the section.
Or,
Click 'Edit' - 'Ttem' - 'Remove item".
If you want to remove the item from multiple views, repeat the procedure for every view.

. Note:
Please notice that the item is still available in the items list in the left section of the

window.
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Define the name of views

Define the name of views

Introduction

W

The 'Edit' menu allows you to add and remove languages within the Job ticket editor.
For each language, you can define the 'View caption:' and 'Description:' for each view.

Select one of the available views from the drop-down list box 'Views'.
Click 'Mark color".
The 'Edit job ticket' dialog opens.

. Select a language.

4. Define the 'View caption:'.

This is the name of the view in the drop-down list box.
Define the 'Description:'.
Click 'Mark color'.
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Define the name of views
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Saving the job ticket

Saving the job ticket

When to do

When you have completed updating the job ticket, you have to save the ticket. The views
on the job ticket will not change unless you save your changes.

When you save the job ticket, the job ticket definition on the Central Server is updated.
All existing jobs on the Central Server are updated according to the new job ticket defini-
tion.

To save the job ticket

1. Select 'File' from the menu
2. Click 'Save'.
Saving the job ticket could take some time. The status bar indicates the progress.

Note:
When you make changes in one of the job tickets and close the Job ticket editor, a dialog
will appear. This allows you to save your changes or close without saving.
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Previewing the job ticket

Previewing the job ticket

When you change the job ticket, the 'Preview' option allows you to check the new job
ticket before distributing it.

You can preview the specific version of the job ticket by clicking the Preview’ button.
Or
Click 'File' - 'Preview'.

The preview window contains a 'Print’ button which allows you to print the previewed
job ticket on paper.

Tip: Changes made in the preview window do not effect the default values of the job
ticket.
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Printing job ticket

Printing job ticket

The preview window contains a 'Print’ button which allows you to print the previewed
job ticket on paper.

Or

Click 'File' - 'Print'.

When you print the job ticket, the default values will be printed. This allows you to check
the defaults.
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Exporting job ticket settings

Exporting job ticket settings

You can export the current job ticket settings to disk. The 'Export' option in the 'File'
menu allows you to export the current Job ticket settings. This allows you to backup the
current version of the job ticket. The 'Import’ option in the 'File' menu allows you to
import the settings and use that version of the job ticket.

. Note:
The job ticket settings will be saved to disk as an Xml-file. It contains information on
the available items, the used items, item settings, job ticket settings, etcetera.
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Importing job ticket settings

Importing job ticket settings

You can import the job ticket settings from a disk. The 'Import’ option in the 'File' menu
allows you to import Job ticket settings. The 'Export’ option in the 'File' menu allows
you to export the settings to disk. This allows you to backup the current version of the

job ticket. When you import the settings again, you can re-use that version of the Job
ticket.
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Printing for
Professionals

Océ helps the people who make our world. Companies
everywhere use Océ technical documentation systems in
manufacturing, architecture, engineering and
construction. High speed Océ printing systems produce
millions of transaction documents each week, such as
bank statements and utility bills. And in offices around
the world, people use Océ professional document systems
to keep the wheels of business and government turning.
Océ is also at work in publishing on demand, newspaper
production and wide format colour for spectacular

display graphics.

For more information visit us at:

WwWww.oce.com
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